
     Contents for cNote Help
cNote acts as a miniature information manager.    It is kind of like a post-it note pad for 
windows only better.    cNote is the first of several products to be released by Cycloid 
Software.    The other products include cTodo, cPeople, cSchedule, and cWhere.
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Technical Support
Free technical support for registered users may be obtained by calling (310) 477-7496.

Also, if you have any questions, concerns, or comments about the program, please let us 
know.



Registration
First of all, Id like to personally thank you for trying cNote.    Even if you do not register the 
program, we would appreciate any feedback you might give us on this product.    Also, 
please send us you name and address so we may put you on our mailing list.

Why register?

Free Technical Support
Receive the latest version of the software
Receive notice of all updates to the software
Information on other products from Cycloid Software
Special discount pricing on other products

How to register?

Print Order Form

Send check or money order for $15.00 payable to Cycloid Software to:

Cycloid Software
1440 Veteran Ave., Suite 569
Los Angeles, CA 90024



Synchronization
Synchronization allows for two database files to be merged in a smart way.    This way, one 
can use cNote on a portable machine and a home machine and not have to worry about 
keeping track of what information is in what computer.

How does synchronization in cNote work?

To begin with, one file must be setup as a master and the other as a slave.    You will see how
these two files differ as you read below.

General Idea:

Every item that is entered in cNote is stamped with a unique entry date.    This field can not 
be seen; it is hidden and internal to the program.    Another internal hidden field is called 
synchronize.    It holds the last date the item was synchronized.    Every time you change an 
existing record or create a new record, the synchronize date is set to Null (cleared).

cNote finds all records in both the master and the slave that have unique entry dates and 
the synchronization date set to Null.    These are records that are new to both the master and
slave files.    These records will be added to both.

Next, if the slave file has an item with a unique entry date (it is not in the master file) but 
has the synchronization date set (meaning at some point it had been merged) then it is 
deleted from the slave.    If the master file has an item with a unique entry date and has the 
synchronization date set, it is kept and added to the slave file.    Therefore, only items 
deleted in the master are truly deleted.

Actual Synchronization Process



Cycloid Software
Cycloid Software is dedicated to providing state of the art, useful and functional software to 
home and business users.    We strive to produce excellent bug free products.    We welcome 
any and all suggestions.

Cycloid Software also produces the Reconciliator, a program designed for accountants and 
bookkeepers to do monthly Bank Reconciliation.

Cycloid Software
1440 Veteran Ave., Suite 569
Los Angeles, CA    90024
(310) 477-7496



William E. Offeman Jr.
William E. Offeman Jr. has been in computing for over 10 years.    Mr. Offeman is the lead programmer for cNote.

He can reached via e-mail at: boffeman@aol.com

or telephoned at: (310) 477-7496

or US Postal mailed at:
Attn: William Offeman
Cycloid Software
1440 Veteran Ave., Suite 569
Los Angeles, CA 90024



 Toolbar buttons

       New Page  

       Delete Page  

       Cut Text  

       Copy Text  

       Paste Text  

       Move First  

       Move Previous  

       Move Next  

       Move Last  

       Display Outline  

       Search  

       Undo  

       Save Changes  

       Always on Top  



     New Page
Selecting either File, New Page, or pressing the New icon creates a new page in the 
database.    By default, the page it titled Untitled and the date/time stamp is set to the 
current system time.    To change either the title or the date/time simply click on those fields. 
See changing the caption and changing the date.

One can also create a new note page by pressing Ctrl+N or from the speed menu.



     Delete Page
Selecting either File, Delete Page, or pressing the Delete icon deletes the current page in the
database.    The program will prompt you with the following dialog box:

Select Yes to delete the item; or select No to abort the delete.

One can also remove a note by pressing Ctrl+D or from the speed menu.



     Cut Text
Selecting the cut text icon cuts the highlighted text in the cNote window.    Cutting removes 
the text from cNote and places the text in the windows clipboard.    The text can then be 
pasted to a different location or program.

This can also be accomplished by pressing Ctrl + X.



     Copy Text
Selecting the copy text icon copies the highlighted text in the cNote window, placing it in the
windows clipboard.    The text can then be pasted to a different location or program.

This can also be accomplished by pressing Ctrl + C.



     Paste Text
Selecting the paste text icon takes the text in the windows clipboard and copies it into the 
current note based on where the cursor is positioned.

This can also be accomplished by pressing Ctrl + V.



     Move First
Selecting the move first icon loads the first page of the database into the cNote window.    
This page is determined by the current sorting order of the database.

This can also be accomplished by pressing Ctrl + Up Arrow or from the speed menu.



     Move Previous
Selecting the move previous icon moves to the previous page in the database.    This is 
determined by the current sorting order of the database.

This can also be accomplished by pressing Ctrl + Left Arrow or from the speed menu.



     Move Next
Selecting the move next icon moves to the next page in the database.    This is determined 
by the current sorting order of the database.

This can also be accomplished by pressing Ctrl + Right Arrow or from the speed menu.



     Move Last
Selecting the move last icon moves to the last page in the database.    This is determined by 
the current sorting order of the database.

This can also be accomplished by pressing Ctrl + Down Arrow or from the speed menu.



     Show Outline
Pressing this icon displays the outline windows.    The outline windows holds the titles of all of
the notes in the database.    It is sorted alphabetically.    The display outline icon will be 
depressed while the outline window is visible.

In the display outline, clicking with the mouse on one of the items loads that note into the 
cNote text window.    Double clicking on an item loads it and then closes the outline window.   
One can also select the close button to close the outline window.

Sample outline window

One can also display the outline from the speed menu.



     Search
Clicking on the search icon, pressing Ctrl + F or selecting Find from the Edit menu will 
display the following window.

Find Window

Enter any text into the Find: text box.    The program will search for your text based on the 
direction criteria.    You may either search for the first occurrence, the next occurrence, the 
last occurrence or the previous occurrence of the text you entered.

The case (upper or lower) of the text you enter is not important.

One can also select to search from the speed menu.



     Undo
Clicking on the undo icon cancels any changes that may have been made to the current note
and restores the note to its original contents.

This is equivalent to selecting Edit, Undo changes from the main menu, or pressing Ctrl+Z.



     Save Changes
When active, clicking the save changes icon causes the current note to be saved to disk.

This is equivalent to selecting Edit, Update record from the main menu, or pressing Ctrl+W 
(write).



     Always on top
Selecting the Always on top tack icon forces the cNote program to be on top of all other 
windows.    The tack will be depressed when the window is set to remain on top.    Clicking 
the button again will return the tack to its normal position and the window will no longer 
always remain on top.

One can also select from the main menu, View, Always on top to toggle how the window will 
behave.



Changing the date
The date can be changed by either clicking anywhere in the date field or by selecting Edit, 
Change Date from the main menu.

The date of a note is used for sorting.

Clicking with the right mouse button on the date field will change the date to the computers 
current date and time. 



Changing the caption
The caption can be changed by either clicking anywhere in the caption field or by selecting 
Edit, Change Caption from the main menu.

The caption of a note is used for sorting and is displayed in the list portion of the outline 
window when that window is visible.



Creating a database of notes
You may create a new database by selecting from the main menu File and then New 
database.

You will be prompted to enter the name of the file you wish to create as the following dialog 
box shows.

If you wish to have that database be the default database every time you start up cNote, 
make sure to select File, Save Settings Now.



Saving your cNote Settings
By selecting File, Save Settings Now from the main menu, cNote will save the following 
information which it will read in when it is started again:

Current active database
Window size and position
Current font and size
Current ordering (by date or by caption)
Sorting order (ascending or descending)
Ontop Status
Toolbar visible or not
Menubar visible or not
Autosave Settings

When you select to save your settings, you will not be given any notice, control will simply 
return to the program.

You can also select to Save Settings on Exit.    This menu item is under the File menu and can
be checked on or off.



Tips & Tricks
Pressing the right mouse button in the text of the note will display the speed menu.    This 
menu display a useful sub-set of the main menu.

Ctrl + Arrow keys control movement within the program.
Ctrl + Up arrow will move to the first record.
Ctrl + Down arrow will move to the last record.
Ctrl + Left arrow will move to the previous record.
Ctrl + Right arrow will move to the next record.

Ctrl+N will create a new note.
Ctrl+D will delete the current note.

Pressing the right mouse button on the date field of a note will update that field to the 
current time and date.    Very useful for making an old item appear on the top of your notes 
stack.

Pressing Ctrl+TAB will insert a tab into a note.

Pressing Ctrl+Home will toggle the menu bar on and off.



Applying a Filter
A filter may be applied to the database.    Only notes that contain the string of information 
typed into the filter will be displayed.

From the main menu, selecting View, Apply Filter, will display the following dialog box:

Filter Window

Enter any string and select OK to set the filter criteria.

When a filter is active, a check mark appears next the the menu item View, Apply Filter.    To 
turn off the filter, select the menu item again; the check mark will disappear.



Order Form
_______________________________________________________________________

Remit to: Attn: cNote Sales
Cycloid Software
1440 Veteran Ave., Suite 569
Los Angeles, CA 90024

cNote Registration Package Qty: _______ @    $15.00 $ __________

CA Residents please add applicable sales tax: $ __________

Total: $ __________

Registration Information

Name: ______________________________________________
Title: ______________________________________________
Company: ______________________________________________
Address: ______________________________________________

______________________________________________

Phone: ______________________________________________
Fax: ______________________________________________
E-Mail: ______________________________________________

Preferred Disk Format:        (    )    5.25              or                (    )    3.5

Where did you get cNote?
________________________________________________________
________________________________________________________

Comments/Suggestions?
________________________________________________________
________________________________________________________
________________________________________________________
________________________________________________________
________________________________________________________



Speed Menu
The speed menu is activated by clicking with the right mouse button on the text of a note.

The menu displayed will allow you to do the following actions:

New Note
Delete Note
Outline
Find
Move First
Move Next
Move Previous
Move Last
Load Text...
Save Text...
Toggle Menu Bar
Toggle Toolbar



Toggle Menu Bar
The menu bar can be turned on or off by pressing Ctrl+Home.

The menu bar can also be set via the right mouse button.    Clicking with the right mouse 
button on the text of a note will display the speed menu.



Toggle Toolbar
The toolbar can be toggled on or off from either the main menu by selecting View, Toolbar; 
or it can be set from the speed menu.



Menu Bar
The menu bar is displayed as the top line of the window; just below the title bar.    The normal items displayed are 
File, Edit, View, and Help.    It is call a menu bar because the items represent selections that can be made.    A single 
click on any of the top items will display a list (sub-menu) of choices.



Load Text...
Selecting Load Text... from either the main menu under the File menu, or from the speed 
menu allows a text file to be read into cNote.

This allows cNote to act similiar to the windows NotePad program.

Also see Save Text...



Save Text...
Selecting Save Text from either the File menu or the speed menu allow the current note to 
be saved as a text file.    This enables cNote to act like a Text Editor.

Although cNote was not specifically designed to become a text editor, you can use it to read 
in any text file, modify the text and then save the file again.



Time Stamp
Pressing Ctrl+T or selecting Edit, Time Stamp will place the current date and time into the 
current note at the current cursor position.



Print
Selecting File, Print will display the below dialog box.

Sample Print Dialog

Use Selection to print only the current note.
Selecting All will print EVERY note in the database.
You can also select to print a range of pages.



Change Font
Selecting View, Change Font will display the below dialog box.

Sample Change Font Dialog

This is the standard change font dialog.



Order By
The database may be ordered by either caption or date, and may be either ascending or 
descending.

To select the order, from the main menu click View, Order By.    One can then check either 
Caption or Date and check on or off Ascending.



Actual Synchronization
When one selects File, Synchronize, the following dialog is displayed:

Sample Synchronization Dialog

Either type in the name of the master and slave databases or select them by clicking on 
Select...

Once both names have been entered, click on Synchronize start the synchronization process.
When the process is finished, the following dialog will be displayed:




